2016 OSlsoft TechCon

Use Data Science
for Machine Learning
and Predictions Based

on your Pl System Data




Use Data Science for Machine Learning and PreditiBased on Your Pl System Data

0OSIsoft, LLC

777 Davis St., Suite 250

San Leandro, CA 94577 USA
Tel: (01) 510-297-5800

Web: http://www.osisoft.com

© 2016 by OSIsoft, LLC. All rights reserved.

No part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form or
by any means, mechanical, photocopying, recording, or otherwise, without the prior written permission
of OSIsoft, LLC.

OSIsoft, the OSIsoft logo and logotype, PI Analytics, PI ProcessBook, PI DataLink, ProcessPoint, PI Asset
Framework (PI AF), IT Monitor, MCN Health Monitor, PI System, PI ActiveView, PI ACE, PI AlarmView, PI
BatchView, PI Coresight, PI Data Services, PI Event Frames, Pl Manual Logger, PI ProfileView, PI
WebParts, ProTRAQ, RLINK, RtAnalytics, RtBaseline, RtPortal, RtPM, RtReports and RtWebParts are all
trademarks of OSIsoft, LLC. All other trademarks or trade names used herein are the property of their
respective owners.

U.S. GOVERNMENT RIGHTS

Use, duplication or disclosure by the U.S. Government is subject to restrictions set forth in the OSIsoft,
LLC license agreement and as provided in DFARS 227.7202, DFARS 252.227-7013, FAR 12.212, FAR
52.227, as applicable. OSIsoft, LLC.

Published: April 11, 2016

Use Data Science for Machine Learning and Predictions based on Pl System Data
Hands-on Lab — OSIsoft TechCon 2016

Lead: Gopal GopalKrishnan, P.E., Solution Architect

Lead: Curt Hertler, Solution Architect



Learning Objectives, Problem Statement and Dataset

Table of Contents

Learning Objectives, Problem Statement and Dataset  .........ccccceeeeiiiiiiiiiiee e 4
Part | — Extracting Pl System Data using the Pl Int  egrator for Business Analytics ................ 9
Part Il — Predict Equipment Failure Using Statistic  al ANalySiS..........ccccvvveveeeiiiiciiiiieeees v, 16
Read the Pl INntegrator file QULPUL.........eiiieee e e e e e rrae s 17
Do some statistics and data MUNGING ......ccoiiiiiiiiiiiee e et e e e sree e e e e raeeeeans 17
Plotting engine failure distribUtioN ........c..oii i e rae e 19
Closer look at Engine 1 - is there a correlation among the variables? ..........cccceeeiiiiiiie e, 23
Use odd numbered engines for traiNiNg ........cooccciiiiii e crrre e e e e e e anrees 25
Extract prinCipal COMPONENES ...cciii it e e e e e e e e et e e e e e e e e e e annraeeeeeesesansrnaeeas 26
Plot engine cycle in terms of PCL and PC2.........eeuiiiiiiie ettt ee e e eecttre e e e e e e e nrrase e e e e eeennnnes 28
g To [ ot 4Vl o TU =} 4o o USRSt 33
Part Ill — Ready the Prediction for Deployment usin =~ g Pl AnalytiCS ........ooocuviieeiieiiiiiiiiiiees e 35
Appendix A: Using Power Bl to Evaluate the Predict  ive Model .......cccccceeevvviiiiieieee s e, 39
Appendix B: Using PIWEDAPT WIth R .....ccoiiiiiis it e et e e 46
Appendix C: Follow-up questions from Part Il ......  ..ooioeiiiiir e 47
FOIOW UP QUESTIONS ..ttt ettt e et e e ettt e e e ettt e e e eeataeeesbteeesenbaeaesantaeeesnstaeeesnsaeeennnes 47
RETEIENCE MALEITAIS ... eeeii e et e et e e e bt e e e et e e e e nneas 48

3|Page



Use Data Science for Machine Learning and PreditiBased on Your Pl System Data

Learning Objectives, Problem Statement and
Dataset

In this Lab, we will walk through a statistical approach to predict equipment failure. We will use sensor
data taken from 100 engines prior to engine failure. We will use the R scripting language to develop a
predictive modelling equation that can be run in real time to predict engine failure before it actually
happens.

In a deployment with about 100 engines which arélar, sensor data such as rpm, burner fuel/diw,rat
pressure at fan inlet, and twenty other measuresr@ns settings for each engine — for a total ofuab
2000 tags — are available. On average, an engisefter 206 cycles, but it varies widely - frofocat
130 to 360 cycles.

Using an open source tool such as R for machimaiteg you will create a multivariate model to pred
engine failures within approximately a 15 cycle edow before they fail. The lab will walk through the
end-to-end data science process — preparing thsetavisually exploring it, partitioning the déba
training and testing, validating the models usingyvusly unseen data, and finally deploying theleto
with AF asset analytics for predictive maintenance.

The lab consists of three parts:

* Part |- Extract data from the Pl System for a set of Engines’ operation parameters into a text file
using Pl Integrator for Business Analytics (BA)

* Partll - Load the exported dataset from Pl System into R, and utilize the functionality in R to
perform machine learning on the dataset for prediction of engine failures.

e Partlll - Convert the output prediction logic from R into an equivalent equation in PI Analytics
for continuous execution and prediction.

The PI System Infrastructure and the Dataset

Let’s start by looking at the AF model that represents the set of engines and take a look at the dataset
for these set of engines.

Open Pl System Explorer from the — = : i
Taskbar. 5 Eé? f"—j “ =114 I@ Eﬁ ‘ m ‘

In Pl System Explorer, ensure that you are connected to the AF @

Server PISRVO1 and looking at Engines database. Select “Database” File Search View Go Tools Help
from the top toolbar and select “Engines” from the Select Database -QU“’D“* =0 % | @eet
dialog.
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Select Database lil
aNew Database X Delete Database % Database Properties (5} Edit Security
| seseteerver: ﬁms&vm | =] e
Databases:
Fiter P |
Mame Deseriptian Last Madified
@ configuration Astore for configuration data.  1/1/1970 12:00:00 AM
@Energy Management 3/14/2016 12:07:52 AM
o 3/13/2016 6:4L:30 PM
TechCan 2015 Data Sdence Lab  3/13/2016 7:26:11PM
3/14/2016 1:10:05 AM
2/18/2016 3:15:26 AM

The AF Database is quite simple, you should see a list of 100 elements at the root level of the database,
each representing an engine:

@ \\PISRVOT\Engines - Pi
File Search View Go Tools Help

aDalahase % Query Date = (0 @ QBack ©) U, Checkln %} « |g'] Refresh | (3 Mew Element «

Elerments ” Elements
Seardh
2y Name | Description
@ | Engne 1 {Engine Template
& Engne_10 Engine Template |
® | @ Engne_100 Engine Template
B | @ Engne_11 Engine Template

E|l= [ & Engne_12 :Engha‘remplat! |

8 | & engne i3 |Engine Template |
B | @ Engne_14 Engine Template |
® | @ Engne_15 Engine Template
w | o E@e_iﬁ .Eﬁglng Tem‘platg |
s | & Engne_17 IEr‘lginzTemplatz
] "ﬂ Erx;he-_.,la .EmineTerl.!Habe“
8 | & Engne_15 | Engine Template
8 | engne 2 | Engine Tempiate. |
a | & Engne_20 lEngim!Te/miar.e [
B | & Engne 21 |Engine Template |

5|Page
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Select an Engine element and look under the Attributes tab to see E (= categary: Engine Sensor

the set of attributes defined for the 21 sensors and 3 settings. In s e,

. . . L] & 2 543.54 °R.
this example, we have kept the attribute names short, i.e. “s3” for e =
“sensor 3”. This makes the R script easier to manage. As you can B | Fsa 1477.2 %
see, these sensors map to the temperatures, pressures, rotation & 55 14.62psa
speeds, etc. measured for each engine. " e s

-] F 57 551,25 psia

= & s8 2388.32 rpm

m & =9 9033.22 rpm
Engine_1 " &Fs10 A3
|_General_i-a11'-ld_if-i|—=_-Eis_i- Attributes i-l;orts | Analyses | Version | " |@su res
B A S PR s & s12 520.08

|E¢.fz.9r ol v| ] Name: 53 = & 513 2388.32 rpm
i i ] < s14 3110.93 rpm
|af' t B9 & Name 2 value & A Description:
1 = o s15

8.5113

B |2 cats : Engine S Pi ties:
. =l ca gory gine Sensor | TOpErues <None> & si6 0.03
= &F s1 513.67 °R Cateqgaries: Engine Sensor ®m & s17 396
o) & 52 643.54 R Default UOM: degree Rankine = & s18 2388
[ 53 Eé;;:;;: ------- Value Type: Single = & 19 o

T [ nrra = Value: 160141 °R. il b 2%
= &F =4 1427.2 R ' - & Eps,
i T | Data Reference:  |PI Paoint

= (?‘ 55 14.62 psia e = Category: Engine Setting

B | |2L6ipsa . | & settingl 0.0003
| | | ISRVO1 ine_1_HPC Qutlet T = &7 setting2 0

a8 & s7 551.25 psia |Wj Fngine_1
| ! . & &7 setting3 100

=] Categary: Engine Status
€ | & Runtime 1]

m &F Status Stopped

The Runtime attribute totalizes the minutes each engine has been running. The Status attribute
indicates the operating status of the engine - Started, Running, Failed, and Stopped.

The attributes shown under the “Failure Prediction” category will be used in Part lll of this lab. They will
contain the results of the predictive model we will implement.
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Now, let’s look at the dataset we will be using for Part I. iE
Right-click on the Status attribute and Trend the
attribute

[ | Cateqory: Engine Status

T E™
B4 & p2
B4 I@'PledidEdStBl'LE

22 Category: PIWebAPT_input

B¢ | Runtime

B & s

New Attribute
MNew Analysis

Reset to Template
Create or Update P| Point

| Ok, Categorize..,
Limits,

Forecasts..

Sl S G D .

|. Trend.
'Em%i

Change the trend time range to start from [& Trend [ [= =]

20-Feb-2016 11:59:00 pm to 21-Feb-2016 Stort T [2202016 13753 PW B B ===

07:00 am and click the Refresh button. S

Although the runtime for each engine is 3

different, this time range is long enough il

to examine every dataset. i

We have backfilled each engine’s dataset U;

starting at 21-Feb-2016 12:00:00 am. e e —— T
[Add tbutes... | [ addPrponts.. | | Traczsn, | | e

We will be extracting this data for all 100

engines in the next section using the Pl Integrator for Business Analytics.

For Engine_1, we see the engine’s operating states for the

all I 51 New Attribute
period, the spike at 21-Feb-2016 3:11 am indicates when the B (@5t |l NewAnalysis
engine failed. To overlay other sensor readings onto the same [0 B 485 | pusioTemplate
trend, right-click on one of the sensor attributes and choose B | Fsh Create or Update Pl Point
Add to Trend. WA S Casgaios

= | & 8 Limits...

L & Forecasts...

u & s10 Time Series Data...

s | & sl Trend

B '.?- 512 Add to Trend |,

. :rﬂ' T Change Display UOM

7|Page
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Feel free to explore the AF model and the
data further. Next step will be to prepare
and export the data for all 100 engines to a
text file.

StartTime: [2/20/2016 11:59 P

[E=][* | Endmme: [2/21/2016 7:00 am =1 E]E

® Engine_1[Status O Engine_L|s21

0.5

o 228

7.02 hours 2/21/2016 7:00:00 AM

[ Add attributes... | [ AddPrPoints... | [ Traces., | [ close
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Part | — Extracting Pl System Data using the Pl
Integrator for Business Analytics

The PI Integrator for BA is a tool developed by OSlsoft to support the integration of real-time operations
data with various environments including:

- Self-service Bl Analytic tools like Microsoft Power Bl, Tableau or Tibco Spotfire
- Data Warehouse databases like Teradata, Oracle or Microsoft SQL Server

- Big Data platforms like SAP HANA and Hadoop

- Statistical analytics tools like SAS and R

In this lab, we will be working with R for predictive analytics. Hence we will use the Pl Integrator for BA
to organize the dataset and publish data into a text file format that can be consumed by R.

Access the Pl Integrator for BA by opening Internet Explorer. The default web site for the Pl Integrator is
https://pisrv01/ . You should see the main page of the integrator, showing a list of previously
configured views:

To get started, select “Create Asset View” from the Pl Integrator’s top menu.

o Create Asset View
i i

b Create Event View

& modsy view

x Remave View

view

=y
e\i’)\@ hitps./pisnO1/ 2 ~ @ 6| @ piintegratorfor Business A, |

=+ Create Asset View | ‘ = Crcae Event View & Moty View R Remove View
& Name | Run Status I Type | Run Mode Start Time: | Eng Time LastRun Time v=|
& Engine 100 Published Asset Once 2121/16 12:00 AM 2021116 7:00 AM 3113116 613 PM
& BiTestz Published Asset Once 2121116 12:00 AM 221116 7:00 AM 31316 7:26 PM
@ Engine Test3 Published Asset Once 221416 12:00 AM 221116 12:00 PM 31116 4:34 PM
& BiTest1 Published Asset Once 22116 12:00 AM 221116 6:00 AM 31316 714 PM |
] Engine_Tests Published Asset Once 2121116 12:00 AM 22116 6:00 AM 3716 10:47 PM ‘
@ Enngine Test7 Published Asset Once 2/21/16 12:00 AM 221116 6:00 AM 37716 10:36 PM |
@ Engine_Tests Published Asset Once 221116 12:00 AM 2021116 6:00 AM 311116 03 PM |
] Engine_Test6 Published Asset Once 2/21/16 12:00 AM 22116 6:00 AM 317116 2.43 PM ‘

Overview Log Security

& Run Status: Published Search Shape

Asset Shape

View Name: Bl Test 2 4 @ Engine_t

Pl AF Database: Engines @ Predicted Status

Publish Target: Text File 5

View Type: Asset

Run Mode: Once

Last Run Time: 3/13/16 7:28 PM

Next, you will be prompted to give your Asset View a name. Enter a name and click “Create View”.

9|Page
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Create New Asset View

Asset View Name

EngineView |

The first step in using the Pl Integrator for BA is to select the data from an AF model. Select the AF
Server “PISRV01” and the AF Database “Engines”. You should see the engine elements appear in the
Assets hierarchy below.

Server PISRVO1 [v] |

Datsbase [ engnes =Bl
7 Assets
1'3 Engine_1
) Engine_10
71 Engine_100
@ Engine_11
) Engine_12
71 Engine_13
Select and drag one of ) Source Assets %, Search Shape
the engine elements Server ER ]| TwAssetShape
into the middle Database | Engines =l e
. « = A Engine_1
section under “Asset it
”
Shape : | £) Engine_1 |A
When elements are selected, the pane below shows the list of @ hssets
1 . € Engine_1
the element’s attributes. These can be selected ad dragged in to B g
the “Asset Shape” area either individually or as groups. zg"“'“—“’“
Engine_11
(@ Engine_12
3 Engine_13
€ Engine_14
@ Engine_15
& Engine_16
) Engine_17
@ Engine_18
& Engine_19 v
Attributes | rirer x|
0O select All
#rc A
&2
§ Precicted Status
‘ Runtime
A st




Part | — Extracting Pl System Data using the Pebriator for Business Analytics

Next, we want to select all the sensor attributes as

Attributes | Firer ® !.?
well as the settings, runtime and status attributes o
. . O Select All rouping
and include them as part of the view. - Ungrouped
0 pcl i
. G by Cati
We can drag and drop all the attributes, but to & 2 e
simplify the process, let’s group the attributes by # Predicted Status Sorting
category. & Runtime Sort A-Z
@ Sort Z-A
# =10
Select and drag the “Engine
Sensor” category into the Select Data > Modify View > Publish
o ”
Asset Shape area and drop @ Source Assets T Search Shape
it as a child to the “Engine_1" s ;e S— = 7 Asset Shape
element. To do this you must  patabase | cogres 21 4 @Enginet TEm—— e
. . &5 Engine Status
position your cursor directly & oo . B Engr -
. 10 rd
over the engine element [ @ engines | : ‘
- 4 & 1 s x
hown in the “Asset Shape” i '
S e “Asset Shape & Engine_10 o x
region. @ Engine_100 &3 %
. ) . D) Engine_n " o /%
Repeat this for the “Engine € Engine_12 _ s 24
Setting”, and “Engine Status” Attributes | rirer =|[¥7] &5 ;%
categories. & 517 P
» jm Engine Sensor
@58 P
» B Engine Setting
- & 10 Pl
| » jm Engine Status |
} . &2 LR
» - Failure Prediction
& 20 k.
After selecting the required attributes, we need to modify % Search Shaps
the asset shape to include all other engines that are based fa/sselShepe .
A Engine_1 b 3
on the same template. ey %
& Runtime s X
. . o . . & Siatus '
Click on the edit (pencil icon) on the right of the selected \

& £ %
engine. This brings up a dialog to edit the asset selection ' '
filter shown below.

11| Page
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Uncheck the filter on “Asset Name” and check the filter Edit Filters
on “Asset Template”. This will expand our selection to [ Asset Name

Engine_1

™ Asset Template  |Engine v

[l Assat Category  |BI Test{v|

include all 100 engines which have been derived from

the “Engine” template in AF database.

*) Add Filter
Ll

Click on Save button to confirm the changes. %, Search Shape  Matches
And you should see that 100 elements derived e R A Found 100 Matches
from the engines template have been found. “ Qengine s % @ Enginet

4 Runtime s xR () Engine_10
Click Next at the top right-hand side of the page & Status S n €) Engine_100
to move to the “Modify View” page (shown ®st ;% () Engine_tt
below). & s10 P () Engine_12

& st 7S Q) Engine_13

& s12 £ () Engine_14

& s13 £ () Engine_15

In the Modify View step, you specify the shape of the dataset to extract. Shaping involves configuring
the time range and interval, aggregations, and filters you want applied when publishing the dataset.

Select Data > Modify View > Publish

== Add Column Y Edit Row Filters §= Edit Value Mode SR B
e e E - =]

Engine TimeStamp Runtime | Status | s1 510 [*=

Engine_1 2016-03-24 06:27:02 192 518.67 13 o

Engine_1 2016-03-24 06:28:02 192 518.67 1.3

Engine_1 2016-03-24 06:29:02 192 518.67 1.3

Engine_1 2016-03-24 06:30:02 192 518.67 1.3

Engine_1 2016-03-24 06:31:02 192 518.67 1.3

Engine_1 2016-03-24 06:32:02 192 518.67 1.3

Engine_1 2016-03-24 06:33:02 192 518.67 13

Engine_1 2016-03-24 06:34:02 192 518.67 13

As mentioned in previous section, the running data for the engines are backfilled for the time period
between 21-Feb-2016 12:00:00 am to 21-Feb-2016 07:00:00 am. Hence let’s change the start and end
time of the view and click on Apply to update the view.

Start Time End Time

2/21/16 12:00 AM ] 2/21/16 7:00 AM | Apply
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Using the “Edit Value Mode” dialog, we have the option to change how = Edit Value Mode
often we sample the data from PI System. The default selection is to Interpolated Values
interpolate values every minute. The data are backfilled at 1 minute Every | minutes

interval, so we can keep the default setting.

As we have seen in the previous section, engines are not running for the Y Edit Row Filters
entire period from midnight to 7am. For this analysis, we are only OR

interested in the sensor data for the time period when the engines are
running and status is not “Stopped”. Hence we will filter and exclude data for periods when engine
status is “Stopped”. Click on “Edit Row Filters” to launch the dialog show below.

Using this dialog, select String to add a new string | Row Filters |

filter and filter based on the Status attribute’s value. | F—— i
ew Row Filter

| Include rows based on whether the contents of a column |
- match a string pattern

| Include rows based on whether the contents of a column |
contain certain digital values

| Include rows based on whether the contents of a column |
contain certain numeric values
Nl

= Include rows where the contents of a column contain a

value |

Include rows where certain Event Frames are active

Specify that for the “Status” column, any record containing the “Stopped” state (double quotes are
required) should not be published. Save String Row Filter and Close the “Row Filters” dialog.
Add String Row Filter

® Include rows where all of these conditions are true
O lInclude rows where any of these conditions are true

|Siatus V| |not equal to V|["St0pped'1 X

Cancel

I Save String Row Hiter

The last shaping step involves renaming and removing columns not required by the R script being used
to analyze this data. First, select the “Engine” column. The “Column Details” panel will show up on the
right-hand side of the page. Change the “Name” field to “id” and Apply Changes.

13| Page



Use Data Science for Machine Learning and PredictiBased on Your Pl System Data

Engine 100 11

® Column Details

Select Data > Modify View » Publish

== Add Column Y Edit Row Filters §= Edit Value Mode Start Time
28 columns 0 Row Filters E:;.??Ii‘:i‘\;lues | 2121116 12:00 AM ‘
Engine TimeStamp Runtime ‘ Status ‘ Data Content
Engine_1 2016-02-21 00:00:00 1 Started 518.67 Name v
Engine_1 2016-02-21 00:01:00 2 Running 518.67
Engine_1 2016-02-21 00:02:00 3 Running 51867 Data Type
Engine_1 2016-02-21 00:03:00 4 Running 518.67 String v
Engine_1 2016-02-21 00:04:00 5 Running 518.67
Engine_1 2016-02-21 00:05:00 6 Running 518.67
Engine_1 2016-02-21 00:06:00 7 Running 518.67
Engine_1 2016-02-21 00:07:00 8 Running 518.67
Engine_1 2016-02-21 00:08:00 9 Running 518.67
Engine_1 2016-02-21 00:09:00 10 Running 518.67

Repeat this step by renaming the “Runtime” column to “cycle” (small letter “c”, R is case sensitive).

Next, select the “TimeStamp” column. In the Column Detail pane, select Remove Column. Also remove
the “Status” column. We don’t need them for our analysis. Note: Although we are filtering the data
based on the “Status” column (not equal to “Stopped”), we do not need it in the published dataset.

J @ Pl Integrator for Businesz X 'Q

L C & https:,-.-’pisr\:(-JhDe5igner
i Apps (@ Pl Integrator for Busi (@) Pl Coresight Pl Coresight - Test =
Bl Test 100 1 Gopal
Select Data > Modify View > Publish
o= Add Column Y Edit Row Filters AL (=7
AR s SR 2212016 +1h
Engine TimeStamp Runtime Status s1
Engine_1 2/21/16 12:00 AM 1 Started 51867
Engine_1 12121716 12:01 AM 2 ‘Running 518.67
Engine_1 12/21/16 12:02 AM 3 ‘Running 518.67
Engine_1 [2/21/16 12:03 AM 4 ‘Running 51867
Engine_1 12121716 12:04 AM 5 ‘Running 518.67
Engine_1 12/21/16 12:05 AM 6 ‘Running ‘518 67
Engine_1 12/21/16 12:06 AM 7 ‘Running 518.67
Engine_1 12/21/16 12.07 AM 8 ‘Running 51867
Engine_1 12121/16 12:08 AM 9 ‘Running 518.67
Engine_1 12121/16 12:09 AM 10 ‘Running 51867
Engine_1 12/21/16 12:10 AM 11 ‘Running 518.67
Engine_1 12121/16 1211 AM 12 ‘Running 151867

We are now ready to publish our dataset. Select Next in the upper right-hand corner of the page to
move to the “Publish” page of the PI Integrator for BA.
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For Target Configuration, click on the
drop down and select Text File. We

Select Data > Modify View > Publish

are also going to perform a one-time Target Configuration Summary
publish of this view. Hence you can Wi Shape and Matches
select Run Once. - + There are 100+ Matching Instances

® Run Once

O Run on a Schedule Timeframe and Interval
Click on Publish to get the PI - + Your Start Time is 2/2116 12:00 AM

. . « Your End Time is 2/2116 7-00 AM

Integrator to start publishing the Ve e ot e
dataset to a file. el SRS S TS e
You will have to Confirm that this is “
Ok.

Then you should be directed back to the page showing the existing list of views. The bottom of the page
shows a run status of the publish action.

Overview Log Security
Run Status: Published Search Shape
]
Asset Shape o
View Name: Engine 100 2 4 [T Engine_1
Pl AF Database: Engines # Runtime
Publish Target: Text File # status
] ® s

View Type: Asset

& s10
Run Mode: Once

& sn
Last Run Time: 315/16 3:19 PM

& s12

Once the publication is finished, open the “Data Science Lab” (C:\Data Science Lab) folder on the
desktop. You will see the text file you have just published. It will be named with your Asset View name
followed by a time stamp.

We will use this file as input to the R script analysis in the next section of the lab.

15| Page
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Part Il — Predict Equipment Failure Using
Statistical Analysis

From the Data Science Lab folder, select Enginp&Briand double-click to open itin R
Studio.

¥ ThisPC » Local Disk (C:) » Data Science Lab

Mame

6 EngineScript.R

The screen below shows the R Studio user interface.

E] RStudio - |8
File | Edit | Code View Plots Session Build Debug Tools Help

-l 22 - [~ Addins = K| project: (None) =
2] EngineSeript.R — =L Environment  History =
7H [JsourceonSave | @ A ~| il ~#run % | #Source - = " [ _#ImportDataset~ | 3 List+
1 ” ~| ) Global Environment ~
2 #pprensrksskescs gead the file output from PI Integrator
3
4
5 e-read.csv("file:///c:/pata Science Lab/Engine 100 6_20160316174237.txt",header=7, sep="\t")
6 view(e)
7 colnames(e)[1]="4d"
8 eSid=as.numeric(gsub("Engine_","",e3id)
9 default_options = options()
10 save(default_options, file = "default_options.rda”)
11 options("scipen"=100, "digits"=4) #use numeric instead of scientific notation for display
12
13 head(e) #Took at the first few rows . Files Plots Packages Help Viewer =
14 [¢ > | Export -
11| (Top Level) + R Script
Console C:/Data Science Lat =0

R version 2.2.3 (2015-12-10) -- "wooden christmas-Tree”
copyright (c) 2015 The R Foundation for statistical computing
platform: x86_64-wed-mingw32/x64 (64-bit)

R is free software and comes with ABSOLUTELY NO WARRANTY.

You are welcome to redistribute it under certain conditions.
Type "license()’ or "Ticence()' for distribution details.

R is a collaborative project with many contributors.

Type "contributors({}’ for more information and

"citation()’ on how to cite R or R packages in publications.

Type "demo()’ for some demos, "help()’ for on-Tine help, or
"help.start()’ for an HTML browser interface to help.
Type 'q()" to gquit R.

>

The following sections show the output when yop skeough the script line by line via
<<Run>>.

The following pages have been extracted from thiptsdocument EngineAll.html (see Data
Science Lab folder for the latest revision).

| . b ThisPC » Local Disk {C:) » Data Science Lab

Marme

21 EngineAllLhtml
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Read the PI Integrator file output

e = read.cav ("file:///C:/Usera/gopal/Documents/UC16/Engine 100 6_20160316174237.txt",
header = T, =sep = "\t")

colnames (e) [1] = "id"

e$id = as.numeric(gsub("Engine ", "", efid)

$ options{'scipen'=100, 'digits'=4) #use numeric instead of scientific notation

$ for display

head{e) #look at the first few rows

i+ id cycle =1 =10 =11 =12 =13 514 315 =16 =17 =118
## 1 1 1 518.67 1.3 47.47 521.66 238B.02 B8138.62 85.4155 0.03 382 2383
2 1 2 518.67 1.3 47.4% 522.28 238B.07 B8131.49 5.4313 0.03 382 2383
$# 3 1 3 518.67 1.3 47.27 522.42 238B.03 B8133.23 5.4173 0.03 350 2383
04 1 4 518.67 1.3 47.13 522.86 238B.08 B8133.83 8.3682 0.03 382 23838
$## 5 1 5 518.67 1.3 47.28 522.19 238B.04 B133.80 8.42%4 0.03 3953 23813
$## 6 1 6 518.67 1.3 47.16 521.68B 238B.03 B132.8B5 85.4108 0.03 391 2388

¥4 519 =2 =20 =21 53 =4 35 56 =7 58
4 100 €41.82 39.06 23.4190 158%.70 1400.60 14.62 21.61 554.36 2Z383.06
£# 100 €42.15% 359.00 23.423¢ 1551.82 1403.14 14.62 21.81 553.75 2383.04
£# 100 €42.35% 38.85 23.3442 1587.99 1404.20 14.62 21.81 554.26 Z3E83.08
£ 100 €42.35 38.86 23.373% 1582.79 1401.37 14.62 21.61 554.45 2383.11
£ 100 €42.37 38.80 23.4044 1582.85 1406.22 14.62 21.61 554.00 2383.06
£ 100 €42.10 38.88 23.366% 1584.47 1396.37 14.62 21.61 554.67 2383.02
i 39 settingl setting2 setting3
## 5046.15% -0.0007 -4e-04 100
i3 9044.07 0.0019 -3e-04 100
## 9052.94 -0.0043 3e-04 100
i3 90459.48 0.0007 Oe+00 100
i3 90585.15 -0.0019 -2e-04 100
i3 904%.88 -0.0043 -le-04 100

L= T B R R

Lo T B R N R

View(e) #look at the full dataset in a grid format

Do some statistics and data munging

summary (&) # Stat summary - guartiles, mean etc.
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w#
##
##
133
w#
w#
##
133
133
w#
w#
##
133
w#
w#
##
##
133
w#
w#
##
133
133
w#
##
##
133
w#

w#
w#
L33
##
##
##
##
##
##
##
##
##
##
##
w#
w#
L33
##
##
##
##

id
Min. 1
1st Qu.: Z8.
Median 52.
Mean 51.
3rd Qu.: 77.
Max. :100.
s11
Min. tda.
1st Qu.:47.
Median :47.
Mean 47,
3rd Qu.:47.
Max. :48
s15
Min. :8.3
1st Qu.:8.4
Median :8.4
Mean ;8.4
3rd Qu.:8.4
Max. :8.5
519
Min. :100
1st Qu.:100
Median :100
Mean ;100
3rd Qu.:100
Max. :100
s3
Min. :157
lst Qu.:158
Median :155
Mean :15%
3rd Qu.:159
Max. :1e6l
s7
Min. 1549,
1st Qu.:552.
Median :553.
Mean :553.
3rd Qu.:554.
Max. :556.
setting2
Min. i-6.
lst Qu.:-2
Median o
Mean : 2
3rd Qu.: 3
Max. &

cycle s1
.00 Min : 1.0 Min :518.
oo 1st Ou 52.0 1st Ou.:518.
00 Median :104.0 Median :518.
51 Mean :108.8 Mean :518.
oo 3rd Ou.:156.0 3rd Ou.:518.
0o Max :362.0 Max. :518.
512 513
85 Min. :518.7 Min. 12388
35 1st Qu.:521.0 1st Qu.:2388
51 Median :521.5 Median :2388
54 Mean :521.4 Mean :2388
70 3rd Qu.:522.0 3rd Qu.:2388
.53 Max. :523.4 Max. :2389
slé s17
25 Min. :0.03 Min. :388.0
15 1st Qu.:0.03 1st Qu.:3%2.0
39 Median :0.03 Median :393.0
42 Mean :0.03 Mean :393.2
66 3rd Qu.:0.03 3rd Qu.:3%4.0
85 Max. :0.03 Max. :400.0
s2 s20
Min. :641.2 Min. :38.14
1st Qu.:642.3 1st Qu.:38.70
Median :64Z.86 Median :38.83
Mean :642.7 Mean :38.82
3rd Qu.:643.0 3rd Qu.:38.95
Max. :644.5 Max. :39.43
s4 55
1 Min. :1382 Min. :14.62
& 1st Qu.:1402 1st Qu.:14.62
0 Median :1408 Median :14.62
1 Mean 1408 Mean 1l4.62
4 3rd Qu.:1415 3rd Qu.:14.62
7 Max =1441 Max. 1l4.62
s8 s9
£} Min. 12388 Min. 19022
8 lst Qu.:2388 1st Qu.:5053
4 Median :2388 Median :3%061
4 Mean :2388 Mean 5065
0 3rd Qu.:2388 3rd Qu.:9069
1 Max $2389 Max. 19245
settingl
000=-04 Min. 1100
.000e-04 1st Qu.:100
.000e+00 Median :100
.351=-06 Mean :100
.000=-04 3rd Qu.:100
.000=-04 Max. 1100

s10
7 Min 1.3
T 1st Ou.:1.3
7 Median :1.3
T Mean :1.3
T 3rd Qu.:1.3
7 Max 1.3
s14
Min. :8100
1st Qu.:8133
Median :8141
Mean ;98144
3rd Qu.:8148
Max. ;9294
s18
Min. 12388
1st Qu.:2388
Median :2388
Mean :2388
3rd Qu.:2388
Max. ;2388
s21
Min. :22.89
1st Qu.:23.22
Median :23.30
Mean :23.29
3rd Qu.:23.37
Max. :23.62
s6
Min. :21.60
1st Qu.:21.61
Median :21.61
Mean :21.61
3rd Qu.:21.61
Max. :21.61
settingl
Min. :-8.70e-03
1st Qu.:-1.50=e-03
Median : 0.00e+00
Mean :-8.87e-06
3rd Qu.: 1.50e-03
Max. §.70e-03
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sapply (e, sd) #sdev for each wvariable

## id cycle =1 s10 =11
## 2.922763e+401 6.88809%=+01 0.000000e+00 0.000000e400 2.670674e-01
## s12 s13 s14 s15 s16
## 7.375534e-01 7.19185%2e-02 1.3%07618=+01 3.750504e-02 0.000000e+00
## 517 518 s1% s2 =20
#% 1.548763e+00 0.000000e+00 0.000000e+00 5.000533e-01 1.807464e-01
## 521 s3 =4 s5 3
## 1.082509%9e-01 6.131150e+00 9.000605e+00 0.000000e400 1.3889852-03
#H s7 s8 s9 settingl setting2
## 8.850%23e-01 7.058548e-02 2.208288e+01 2.187313=-03 2.530621=-04
## setting3

## 0.000000e400

e = subset(e, select = -c(setting3, sl1l, s5, sl10, slé, sl18, s19)) #based on sdev, delete columns that are not chan

ging

Plotting engine failure distribution

e.fail = tapply(eScycle, e$id, max) #get cycle number when engine failed
e.fail #display the list of engines and when they failed

## 1 2z 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18
#% 192 287 179 189 269 188 259 150 201 222 240 170 163 180 207 209 276 195
## 19 20 21 22 23 24 25 26 27 28 29 30 31 32 33 34 35 3¢
#% 158 234 195 202 168 147 230 199 156 165 163 154 234 191 200 195 181 158
#% 37 38 39 40 41 42 43 44 45 46 47 48 4% 50 51 52 53 54
#% 170 194 128 188 216 1596 207 192 158 256 214 231 215 198 213 213 195 257
## 55 56 57 58 59 60 61 62 63 64 65 66 67 68 69 70 71 72
#% 193 275 137 147 231 172 185 180 174 283 153 202 313 199 362 137 208 213
#% 73 74 75 76 77 718 79 80 81 B2 83 B84 85 86 B7 88 89 90
#% 213 166 229 210 154 231 199 185 240 214 293 267 188 278 178 213 217 154
##% 91 92 93 94 9585 96 97 98 99 100

#% 135 341 155 258 283 336 202 156 185 200

library (ggplot2)
gplot(y = e.fail, = = l:length(e.fail), main = "Engine failure", ylab = "cycle",
xlab = "id"™)
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summary (e.fail)

## Min. 1st Qu. Median Mean 3rd Qu. Max.
## 128.0 177.0 195.0 206.3 229.2 36z2.0

hist({e.fail, 10, ylab = "freguency", xlab = "cycle", main = "Histogram of engine failures") #histogram, 10 bucket

s

Engine failure
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id
summary (e.fail)
# Min. 1st Qu. Median M=an 3rd Qu. Max.

## 128.0 177.0 189.0 206.3 229.2 362.0

hist{e.fail, 10, ylab = "frequency", xlab = "cycle", main = "Histogram of engine failures") #histogram, 10 bucket

s
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Histogram of engine failures

wn
o]
o
o™
== . _
Q —
c
(]
3
g
E 2 7
m —_
o — I [
[ [ I | |
150 200 250 300 350
cycle
hist{e.fail, 200, ylak = "fregquency", xlab = "cycle", main = "Histogram of engine failures") #histogram, 200 buck
ets
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Histogram of engine failures

frequency

150 200 250 300 350

cycle

efrul = e.fail[efid] - efcycle #rul remaining useful life; add the column toc dataset

# Look at the Grid to confirm
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Closer look at Engine 1 - is there a correlation am  ong the variables?

el = subset(e, id == 1) #let's take a closer look at enginel - subset data for el
e2 = subset(e, id == 2) #and for enginel
el.obs = subset(el, select = -c(id, cycle, rul)) #separate the obssrvations for el

head(el.obs) #look at the first few values and confirm the numbers look OK

#h s11 slz2 s13 s14 s15 s17 52 s20 s21 s3
## 1 47.47 521.66 23B8.02 B138.62 8.4195 352 641.82 39.06 23.41%0 1589.70
## 2 47.45 522.28 23B8.07 8131.49% 8.4318 352 642.15 39.00 23.4236 153%1.32
## 3 47.27 522.42 2388.03 8133.23 8.4178 390 642.35 3B.95 23.344Z 1587.99
#4# 4 47.13 522.86 23B8.08 8133.83 8.3682 352 642.35 38.88 23.373% 1582.79
## 5 47.28 522.19% 2388.04 8133.80 8.42%4 353 642.37 38.50 23.4044 1582.35
## 6 47.16 521.68 2388.03 8132.85 8.4108 391 ©642.10 38.98 23.3669 1584.47
## s4 s6 s7 =8 =9 settingl setting2
## 1 1400.60 21.61 554.3¢ 2388.06 9046.1% -0.0007 —4e-04
## 2 1403.14 21.61 553.75 2388.04 5044.07 0.0019 —-3e-04
## 3 1404.20 21.61 554.26 2388.08 9052.%4 -0.0043 Je-04
## 4 1401.87 21.61 554.45 23B8.11 9049.4¢8 0.0007 O=+00
## 5 1406.22 21.61 554.00 2388.06 9055.15 -0.0019 -2e-04
## 6 1398.37 21.61 554.87 2388.02 9049.68 -0.0043 —-le-04

sapply(el, sd) #sdev for variables for enginel; note s6é sdev is zero

LR id cycle =11 512 s13
## 0.0000002400 5.556978e401 2.683460e-01 7.491763e-01 7.65%6013=e-02
LR s1l4 =15 =17 s2 s20
## 5.5631292400 3.412461e-02 1.475661e+00 4.867952e-01 1.665984e-01
LR s21 s3 s4 =6 =7
## 1.0510132-01 5.75%776e+00 B8.565610e+00 0.000000e+00 9.104140e-01
## s8 s9 settingl setting2 rul

## 7.091352e-02 4.511853e400 1.553446e-03 2.822825e-04 5.556%782+01

el.cbs$sé = NULL #remove s& since sdev=0

el.cbs.cor = cor(el.obs) #get correlation among wvariables

el.obs.cor #look at the raw numbers

## =11 s12 =13 s14 s15
## =11 1.00000000 -0.83567272 0.83070510 -0.76847549 0.7488256%
## slz2 -0.83567272 1.00000000 -0.82538617 0.74761844 -0.76568432
## s13 0.830705%10 -0.82538¢17 1.00000000 -0.78084011 0.74742065
## s14 -0.7884754% 0.74761844 -0.78084011 1.00000000 -0.66288631
## s15 0.748825698 -0.76968432 0.74742065 -0.66288631 1.00000000
## s17 0.70648126 -0.6%510642 0.65167504 -0.6150%229 0.63848857
#+ s2 0.70892236 -0.70945643 0.65312704 -0.65032042 0.63735833
#+ =20 —-0.74584382 0.73152497 -0.731%2400 0.85703426 -0.65275475
## =21 -0.76705481 0.7337%861 -0.78624008 0.7081e583 -0.71270523
## =53 0.64583708 -0.63068412 0.61343%06 -0.59324696 0.54474263
#+ =54 0.81734355 -0.836804063 0.8189318% -0.75720%76 0.72788585
## =57 —-0.79%25314% 0.76669662 -0.82903694 0.75923573 -0.705016%90
#+ =8 0.84908656 -0.82704263 0.82595027 -0.765904065 0.71671389
#+ =59 -0.50641451 0.46689444 -0.44611064 0.40002014 -0.3%006G34

## settingl -0.0748435%1 0.10118350 -0.129%5547 0.15461020 -0.083%8133
## setting2 -0.02963625 0.08383545 -0.04934473 -0.04908604 0.06076079
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## s17 s2 s20 s21 s3
## sl11 0.706481260 0.708%22359 -0.74584382 -0.76705481 0.645837085
## =12 —-0.695106422 -0.709456432 0.73152497 0.733798681 -0.630684121
## =13 0.691675035 0.693127036 -0.73152400 -0.78624008 0.613439058
## =14 —0.61909%2292 -0.650320420 0.69703426¢ 0.70816583 -0.593246956
## s15 0.638489572 0.637358325 -0.65279475 -0.71270523 0.544742629
## s17 1.000000000 0.648226680 -0.61821418 -0.59733207 0.546325528
## =2 0.648226680 1.000000000 -0.68868414 -0.67493600 0.533592780
## =20 —-0.616214183 -0.608086584144 1.00000000 0.69601165 -0.470541419
## =21 —0.597332070 -0.6749359%% 0.69601165 1.00000000 -0.583545857
#+ =3 0.546325528 0.533%92780 -0.47054142 -0.583545%¢ 1.000000000
#+ s4 0.69118591e¢ 0.715269184 -0.72241582 -0.74452806 0.600407683
## =7 —0.655866038 -0.685220441 0.74473482 0.7091127% -0.612002343
#% =8 0.683807028 0.72527914¢6 -0.71594555 -0.76094272 0.616465028
## =9 —-0.392893764 -0.378997689 0.43390382 0.40927155 -0.342261063

## settingl -0.1089%964405 -0.117885277 0.10266482 0.07221062 -0.064242585
## setting2 -0.003063662 -0.002559571 0.04270554 -0.01268866 0.008844666

## =4 s7 s8 s9 settingl
## sii 0.81734355 -0.79253145%4 0.848086563 -0.50641451 -0.07484391
## =512 —-0.83804063 0.786658631 -0.827042625 0.46685%444 0.10118350
## =513 0.81893169 -0.829036942 0.825950267 -0.44611064 -0.12%99547
## sl4 -0.75720976 0.75%9235726 -0.78%040652 0.40002014 0.15461020
## =15 0.72788595 -0.705016899 0.716713894 -0.39006634 -0.08398133
## s17 0.69118592 -0.655866038 0.683807028 -0.39289376 -0.10896441
#+ s2 0.71526918 -0.689220441 0.725279146 -0.3789976% -0.11788528
## s20 -0.72241582 0.744734821 -0.715945551 0.4335%0382 0.10266482
## s21 -0.74452806 0.709112791 -0.760942723 0.40%27155 0.07221062
## s3 0.60040768 -0.612002343 0.618465028 -0.34226106 -0.06424258
## s4 1.00000000 -0.799178266 0.814544317 -0.42570953 -0.12023640
#% =7 -0.799%17827 1.000000000 -0.808018046 0.40213333 0.10421542
#% =8 0.81494432 -0.809018046 1.000000000 -0.456893545 -0.15834455
## s9 —0.425709853 0.402133334 -0.458535453 1.00000000 0.06295341
#% settingl -0.12023640 0.104215415 -0.15834454% 0.06255341 1.00000000
#% setting2Z -0.01500111 0.006118427 -0.007956821 0.03300548 -0.09819150
4 setting?2
## sl11 -0.029636254
## sl2 0.083835448
## =13 —0.045344730
## =14 -0.045086045
## =15 0.080760795
## =17 -0.003063662
#% =2 -0.002959971
## =20 0.042705544
## =21 -0.012688660
#% =3 0.008844666
#% s4 -0.015001112
#+ s7 0.006118427
## s8B -0.007956821
#+ s9 0.033005477

#4 settingl -0.098151499
#4 setting2 1.000000000

library(corrplot) #load library
par.defaults = par(no.readonly = TRUE)
save (par.defaults, file = "R.default.par.RData") #save plot defaults for later use

corrplot (el.obs.cor) #plot correlation
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B
— o M ~ D P~ LB =2 =
PR TR PR B B B SR B I
11 9000000000000 *
2 0000000000000 ° 08
1 0000000000000
9000000000000 e
- 0000000000000 0.4
7000000000000 0
20000000000000 02
20 0000000000000 ° ;
21 0000000000000 ¢
< 0000000000000 02
« 0000000000000
7 0000000000000 e
290 0e ® so0@®
setting1 e o] | | e | . -0.8
setting2 . P

Use odd numbered engines for training

e.obs = subset (e, id,

head (e.chs)

select = —-c{cycle, rul))

## s11
## 1 47.47
## 2 47.49
## 3 47.27
## 4 47.13
#% 5 47.28
## 6 47.16
##

#% 1 1400.
## 2 1403.
#% 3 1404.
## 4 1401.
## 5 1406.
## 6 13%8.
e.odd.obs

521.
522.
522.
522.
522.
521.

s4

60 21
14 21
20 21
87 21
21.61
37 21

s12
1)
28
42
g6
13
€8
56

2388.
2388.
2388.
2388.
2388.
2388.

.61
.61
.61
.61

.61

554.
553.
554.
554.
554.
554.

s13
02
a7
03
08
04
03
s7
36
75
26
45
00
&7

= subset (=.0bs,
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s14
8138.62
8131.4%9
8133.23
8133.83
8133.80
8132.85

2388.
2388.
2388.
2388.
2388.
2388.

s8
06
04
08
11
a6
02

=51d%%2

s15
8.4195
8.4318
8.4178
8.3682
8.4294
8.4108
s9

=17
392
392
390
392
393
391

641.

642
642
642
642
642

#obs for all engines

52
82
.15
.35
.35
.37
-10

#look at the first few values and confirm the numbers look OR

s20
39.06
39.00
38.95
38.88
38.90
38.98

23.
23.
23.
23.
23.
23.

settingl setting2

s21
4180
4236
3442
3738
4044
3669

1589,
1591.
1587.
1582.
1582,
1584.

s3
70
82
k)
79
a5
47

9046.
9044.
9052.
5049,
9055.
50489,

= 1)

19
a7
94
48
15
88

0.
0.

-0

0.
0.
-0.

#odd

0oo7
0019
.0043
ooo7
0018
0043

-4e-04
-3e-04
Je-04
Oe+00
—2e-04
-le-04

engines - observations only
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Extract principal components

e.odd.pca = prcomp(e.odd.cbks, scale = T, center = T) #fit principal components (BC), use only odd engine data

summary (e.odd.pca) #look at PC contributions

#% Importance of components:
## epCl pC2 PC3 BC4 PCS PCE
## Standard deviation 3.0043 1.4670 1.01012 0.55%519 0.97771 0.63574
# Proportion of Variance 0.5309 0.1266 0.06002 0.05826 0.05623 0.02407
## Cumulative Proportion 0.5309 0.6575 0.71754 0.77579% 0.83203 0.85610
4 ec? PCiH BCS EC10 PCll PClZ
## Standard deviation 0.6032 0.58852 0.5501% 0.53628 0.49954 0.4479
#% Proportion of Variance 0.0214 0.02037 0.01781 0.01704 0.01468 0.0118
## Cumulative Proportion 0.8775 0.89787 0.91568 0.%3272 0.94740 0.9592
## BC13 pCl4 pCls PC16 PC17

## Standard dewviation 0.43739 0.41394 0.40052 0.37833 0.16538

# Proportion of Variance 0.01125 0.01008 0.00%44 0.00842 0.001e6l

## Cumulative Proportion 0.9%7046 0.58054 0.%85%7 0.%983% 1.00000

lozd ("R.default.par.RData")
par (par.defaults

screeplot (e.odd.pca, type = "line", main = "Screeplot”) #screeplot
Screeplot
O
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e.pr = predict(e.cdd.pca, e.cbs) #predict for all engines — but using model fit based on only odd engine data

head(e.pr) #lock at the first few rows - these are in terms of BCs
# PCl pC2 PC3 pC4 PC5 PCE
#H -2.579784 -0.5305803 1.15140%8 -0.3097415 -0.81013076 0.82916426

1
## 2 -1.982479 —0.8503658 0.1721622 -1.0657629 —0.84199%682 0.9%630304%
#4 3 -2.609334 -0.6269731 0.37141%4 2.0887107 0.5520411% 0.54551121
#% 4 -3.009002 -0.9115345 -0.28306%0 -0.1297345 -0.32977079 -0.39202173
## 5 -2.063739 -0.4313629 0.9711654 0.4216735 —-0.38192589 —-0.72831083
#4# 6 -3.283768 -0.6027247 1.3815984 1.4374694 -0.09538299 0.06675428
## j=lo} PCE PCS 2Cl0 BCll BCl2

#% 1 -0.609300635 -0.35200453 0.0423%202 -0.69866185 0.23533245 -0.1536808
#% 2 -0.292776817 -0.04814031 -0.34816417 -0.65306452 -0.02198571 0.1862107
## 3 1.184176200 -0.327017%6& 0.31599377 -0.09438622 -0.13612781 -0.31e8786
## 4 -0.0008605%% 0.1003217% -0.09154%42 1.15685502 0.34151314 -0.8165153
#% 5 -0.341011329% -0.02865155 -0.51346334 -0.17619308 -0.14535820 -0.100866S
#% 6 0.3399449%963 -0.34242459% 0.29115428 -0.03869910 -0.2726225%2 -0.2042652

## PC13 PCl4 PC15 PClé PC17

# 1 0.04401746 -0.8946445 -0.45792303 -0.37182178 -0.336241717

## 2 0.09372164 0.217%582 0.36080959% -0.69%208000 -0.155761131

#% 3 0.10050245 0.8096518 -0.38154821 -0.05050710 0.059800048

#% 4 -0.54913207 1.19%21734 -0.1280568% 0.12100721 -0.067555725

#% 5 0.38146247 0.4616110 -0.14741048 0.05076316 0.10181983%
[

## 0.14767365 -0.6128534 -0.0208%315 0.58368569 -0.00358%362

# get pcl egquation

peleg = "
for (j in 1:17) {
pcleg = cat(sep = "", pcleqg, "+(", "'", names(e.cdd.pcaScenter[j]), """, "-(",

e.odd.pca%center([j], ™)™, ")/", e.odd.pcalscale[j], ™*", e.odd.pcaSrotation[],
11)

## +('s1l'-(47.51488))/0.2701003*0.3090%13+('=12"'-(521.4901))/0.7517117*-0.3049236+("'=s13'-(2388.08)),/0.07484883*0.
2845465+ ('s14"'-(8143.502))/19.7965*%0.04163657+("s15"'-(8.438634))/0.03782789%0.28668222+("'s17'-(3583.0714))/1.561964*
0.26B85557+('s2"-(642.638))/0.5043607*%0.27346674+('s20'-(38.83337))/0.1812555%-0.28192194+('s21'-(23.29963))/0.108387
2%-0.28345254("s3"-(15%0.048))/6.186916*0.26044444('54"-(1408.104))/9.077463%0.3006121+('s6"'-(21.60576))/0.0015382
59*0.06360376+('s7"-(553.4522))/0.8983562%-0.2955252+("s8"'-(2388.051))/0.073688822*%0.2847322+("s5'-(5064.651))/22.7
2082*0.08204075+ ("settingl'-(-3.554525=-05))/0.002184843%0.003580013+4("setting2'-(5.022518=-06))/0.0002531555*0.00
3136759

# get pc2 eguation

pcZeg = "

for (j in 1:17) {
pcZeq = cat(sep =

r

pcZeq, "4+(", ™'", names(e.cdd.pca$center[jl), """, "-(",
e.odd.pca$center[j], ™))", ")/", e.odd.pca$scale[j], "*", e.odd.pca$rotation[]j,
21)

## +('s11'-(47.51488))/0.2701003%-0.005176845+ ('s12'-(521.4501))/0.7517117*0.05515457+('s13'-(2388.09))/0.07484863
*-0.23407294("s14"'-(8143.502))/19.7965*0.66696124+("s15"'-(8.438634))/0.03782789%0.02955775+('s17"'-(393.0714))/1.5861
SE4*0. 08849074+ ("'s2"-(642.638))/0.5043607*0.02542645+ ('s20'-(38.83337))/0.1812555*%-0.02673732+("s21"'-(23.295%63))/0.
10836872%-0.0353763594+("'s3"-(1550.048))/6.1865%16*0.08201156+4+("s4'-(1408.104))/9.077463*0.02025%07+("'s6"'-(21.60876))/
0.001535259%-0.04061592+ ("'s7'-(553.4522))/0.8983562%0.04585588+4 ("'=3"-(2386.091))/0.07388822*-0.2283776+('=s5"- (5086
4.651))/22.72082%0.6501037+("settingl'~(-3.554525e-05))/0.002134643*-0.004670446+ ("'setting2'-(5.022518=-06))/0.000
2931999*%-0.00809504

efpecl = e.pr[, 1] #pcl column added to dataset
efpcZ = e.pr[, 2] #pc2 column added to dataset
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Plot engine cycle in terms of PC1 and PC2

ggplot (subset (e, e$id < 4)) + aes(x = pcl, y = pc2, label = rul, color = factor(id)) +
geom_text () + ggtitle("RUL (remaining useful life) for Engines 1, 2 and 3") #plot first 3 engines using PCl a
nd PCZ2

RUL (remaining useful life) for Engines 1, 2 and 3

factor(id)
a 1
a2
a 3

pcl

ggplot (subset (e, e$1d < 4 & efrul < 15)) + aes(x = pcl, y = pc2, label = rul, color = factor(id)) +
geom_text () + ggtitle("RUL(remaining useful life) for Engines 1, 2 and 3") #zoom in where rul<ls
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RUL(remaining useful life) for Engines 1, 2 and 3

]

45
6-
factor(id)
(911 : 1
g 0 a 2
10 é - =
14 5 5 3
4 40 7 19 'g 3°
D_
== E
4 5 8 7 '

efidrul = paste(sep = "."
library (ggrepel)
ggplot (subset (e,

, e5id, eSrul)

gfrul == 0)) + aesix = pcl,

y = pc2, label = idrul, color = factor(id)) +
geom_text () + ggtitle("RUL{(remaining useful life)=0 for all engines")
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pe2

RUL{remaining useful life)=0 for all engines

factor(id)

3 1 a2t a 41 a @

8

— 2 8 22 g 42 a 82 82
Y aaw 3 73 a 5 am g8
2 4 8 24 a8 a 84 a 84
7 380 5 8 2% a 4 3 6 3 8
8 5 20 a #4 3 & o
e 400 T 8 T a & 18 '
0.0 28 a 2B a3 4 5 % 3 8
a 9 a 2% a3 ¥ a9 8
a W 8 0 a 50 70 =2
L:‘J M a M an kil 5
L 28 Ba 8 2 o4 om
5 4 e 3 8 33 A 8 T3 83
- 4 8 M4 a 54 T4 94
5 & 35 A 55 7 & 85
% - a % a 38 a %8 a 7 %
< a 17 & 37 & 57 v &7
e il 0 3 18 838 4 5 78 3
- e 22 3 19 a 15 a 8 a 7
29 20 a 0 a W 0 100
2 . 7
1.0
39170
I ) pet
library(zoo)
##
##% Attaching package: 'zco'
#% The following objects are masked from 'packages:base':
##
4 as.Date, as.Date.numeric
eSpclma3 = ave (e$pcl, e$id, FUN = function(x) rollmean(x, k = 3, na.pad = T, align = "right")) #use a 3 moving av

erage instead of single wvalue

ggplot (subset (e, e$pclma3 > 6)) + aes({x = id, v = rul, label = rul, color = factor(id)) +
geom_text () + ylab("RUL - remaining useful life")
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RUL{remaining useful life) @ pcima3=6

z 2 2z
2 2 factor(id)
- 20 20 a1 a 21 g 4 @ 61 g B
18 18 a2z a 8 2 a8 a8
3 23 43 63 a 83
8 18 18 1 18 1 — ol : B !
a 4 a2 24 g 44 g B84 5 B4
7 717 17 7 o 17
35 a % a 4 a6 g
16 6 18 1% 16 15 18
26 a2 s % a6 a8
157 15 {545 s 1545 18- 15 15 3 ElwBlvmiiiais
2 14 14 14 14 14 14 14 14 14 4% a 2 a ¥ 508 4 &8
%
4 3 13 13 13 13 13 13 12133 1 12 13 13 a9 a2 & 4 5@
E]
= 12122 12. 12 12 12 12 12 2 12 z 12 42 132 12. 122 122 12 1212 12 {2 810 a8 058 ¥aNaN
s
£ 1®oa M & HoE T AL
8 "o - URCT I o1 oMo 1t A1 1" RN EIRE RS G E 1111 11 "nooam u = = = S
= 2123 2 g 2aT2a®
EE 10 101010 0 10 10 10 10 00 10 100 - 10 10 10 10 10- 1000 10 10l 101010 10 10 10 10010 4D
4 13 A& 33 & 538 73 a =
3 839 59 g9 3 85 89 ] 55§ 9 58 § G5 8% 9 55588 3 § &9 & a
4 14 a8 4 a3 54 a ™ a M
3 85 8388 88 8 B 8B B B 8 885 B8 88 8 383 s 888 a & 8se 0B Rl s
FUT AT BT T, T TUTL T AT 7 T TLAT TET T 318 4 3% & 6583 10 3 %8
6666 6666 66 EBE 66 66 B85 65E6E 517 8 3 & & & 7oA
5 &5 B 18 a 38 8 588 78 a S8
a 19 & 4 59 & ™ a 3
. - 320 2 40 & 008 B0 3 100
g 16 e 0 N e G 0 B o o it 06O 6 e 46 B O o G 0 B 1L e T B U e A e e R T R e 0 e (0 U0 e B 6 B (0 (5 e 5 1 B 0 o A i e e e 8 e 1 s e e s I 1 e e e e e e WA U R i 6 e Ol I
0 0.00.00000000000000300000000000000000000000000000000000000000000000000000000-000000.00000000000.000000.000
] 5 5 7 ®
it
ggplot (subset (e, e$pclma3 > 7)) + aes(x = id, y = rul, label = rul, color = factor(id)) +
geom text() + ylab("RUL - remaining useful life")
RUL{remaining useful life) @ pcima3=7
13
factor(id)
g i 8 1 a 21 g8 41 a 61 a Bt
a 2 a 8 42 a 82 a 82
= ‘a 10 1010 4% a 23 a 43 a6 a8
a 4 a2 24 g 44 g B84 5 B4
g g g 8 a5 a 2 g 45 a6 & 8
26 a2 s % a6 a8
& 3 2 8 g i a 7 4 271 g &7 a 67 3 &8
2
= a 8 4 28 g 48 5 83 3 89
2
g 7 7 7T 7 7 7 T T 7 T 7 7 a3 a g ® =0
= ,
=t a 10 g W g 50 £l
&
E & 6 6 66 5 & E 66 48 e - a 1M a M a Bl oa 71 oaw
3 a1Z g g 2a2aw
2
;) B s i I 4 . o e 5 ‘ = ol 3132 Ba BoaTdaw
4 143 M e 58 T™a
415 a 3% & %5 aT5a
4 44 4 4 4 4 4 4 4 4 4 4 4 4 4 4 4 44 4 4 444 4 4 4 4 4
a 18 3 % a ®oa e 49
417 a 3 & a7 oa®
33 33 3. 33 3 323 3 33 2333 3 a a3 3, 3333 33 3 3 3 3 33 3 3 33
518 8 3 5 58 &8 T8 a %
315 a s 58 & 79 4 10
22 2 2 2z 22 2222 2 293 22 32
a2 a3 40 5 80 & 8
AR M T A A T O 1 R 1 T T o 7 A A 501 O O 6 O N T R e RS
0 00000000000000000400000000000000000000000.000000.000000.0 00G00000000D0000000-00000000000 0000000000000
] 5 2 7
it
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RUL - remaining useful life

ggplot (subset (e, e$pclma3 > €.5)} + aes(x = id, y = rul, label = rul, color = factor(id)) +
geom_text() + ylab("RUL - remaining useful life")

RUL{remaining useful life) @ pc1ma3d=6.5

factor(id)
" F o . a1 @ 21 g 41 a 61 a 8t
a 2 a 22. g 42 g 62 82
a3 g 28 a #8838
a 4 a 24 g ¥4 a 8 24
- - . leess ' 5 a 2% 8 45 8 8 3
11 " 1 11 11 1 B[ i 08 (i) 208 0.8 00 iRl-6
a7 a2 a# a6l 81
o 1 10 10 10 10 1 : 1 1010 1 1 1 i 1 i 8 5 % deles &
E 9 9 § 2 g 89 8 29 8 49 869 a3 89
- . 10 a 5 Nan

g 8 8 8 28 2 88 8 2 888 B 8 2 a 1t 8 3 & 51 a ™ a.Nn
a12a Rafam2a®
d e ! d d ! a 13 a 33 a 8 73 & 23
& 66 6 8 @8 & ® & ® 5 6 & & 66 4 148 3 3 6487 3w
8 16 8 35 & 55 75 95
5- 55 5 & 5555 §565 § 5855 & 55 555556 SEEES 5 5 5 o lls = Wi
a4 7 a 37 & 5 W a7

44 44444 qadss 4 dase 44444 4444444 44 44 44 444 44 4 44 4444 44 4dadsad g 4444 & A3
5 18 3 3B & 588 7@ a 88
3 3 4 19 & 39 4 58 & 7™ )
320 2 4 3 608 B 4 100

TRIR TR TR I R R TR N TR (0 N U I SN GI 10 S0 T 10000 1 16 1 (6 0 A A R0 T R A (0O 0 T A N R R 16 R

(] 000000000 00000 0000000000000000000000000000:000000000000000000000 oo 0000000000 6000000

] = 5 ™ 0

it

tapply (subset (e, efpclma3 > 6.5)%rul, subset(e, efpclma3d > 6.5)5id, max)

#% 1 2 3 4 5 & 7 & 3 10 11 12 13 14 15 1§ 17 18
# & & 2 s 5 11 7 7 1 1 2 10 4 5 4 17 7T 3
#% 1% 20 21 22 23 24 25 26 27 28 23 30 31 32 33 34 35 36
# 10 3 2 13 3 5 & 2 2 7 5 8 12 4 3 5 %
#% 37 38 3% 40 41 42 43 44 45 46 47 48 4% 50 51 52 53 54
# 7 ¢4 10 s 4 5 & 4 3 8 5 1 11 8 2 & 5 4
#% 55 5 57 58 53 80 61 62 63 64 85 68 €7 68 63 70 71 T2
#% 3 & 5 3 & 3 11 3 11 4 1z 15 3 17 &

# 73 74 75 76 77 78 73 =0 81 82 23 84 85 86 87 28 89 30
$ 13 ¢ 9 11 4 5 4 7 5 10 9 4 1& T 3 3
#% 91 92 93 94 95 9§ 97 98 99 100

# 9 5 3 7 3 11 3 4 & 10
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summary (tapply (subset (e, e$pclma3 > 6.5)5rul, subset (e, efpclma3 > 6.5)5id, max))

Min. 1lst Qu. Median Mean 3rd Qu. Max.
1+ 1.00 4,00 5.00 6.25 8.00 17.00

sd (tapply (subset (e, eSpclma3 > &.5)5rul, subset(e, eSpclma3 > £.5)5id, max))
## [1] 3.534462

hist (tapply (subset (e, eSpclma3 > 6.5)5rul, subset(e, eSpclma3 > 6.5)5id, max), main = "Histogram - Preidcted RUL

(remaining useful life)",
xlab = "RUL")

Histogram - Preidcted RUL (remaining useful life)

20
L

15
|

Frequency

RUL

Predictive Equation
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pcleq =
for (j im 1:17) {

mu

pcleqg = cat(sep = ; pcleg, "+(", "'", names(e.ocdd.pecafcenter[j1), "'", "-(",

e.odd.pcafcenter[j], ")", ")/", e.odd.pcaSscale[j], "*", e.odd.pcaSrotation[],

1]1)

## +('sl1'-(47.51488))/0.2701003*%0.3020913+("'s12"'-(521.4501))/0.7517117*-0.30459236+("'=s13"'-(2388.09))/0.07484883*0.
2845465+ ("s14"-(8143.502))/19.7965%0.04163657+("s15"-(3.433634))/0.03732789%0.2868222+('s17'-(393.0714))/1.561964*
0.2685557+('s2"-(642.638))/0.5043607*0.27346674+("'520"-(38.83337))/0.1812555*-0.28192194("'=521'-(23.29963))/0.108387
2%*-0.2834525+("s3"-(1550.048))/6.186916*0.2604444+("54"-(1408.104))/9.077463*%0.3006121+('s6"'-(21.605876))/0.00153%2
55%0.06360376+('s7'-(553.4522))/0.8583562*-0.2955252+("s68"'-(2388.051))/0.073688822*0.2847322+ ("=s5"'-(5064.651))/22.7
2082%0.08204075+ ("settingl'~(-3.554925=-05))/0.002184843%0.003580013+ ("setting2'-(5.022518e-06))/0.00025318%9*0.00
3136759

pcZeq = cat(sep = "", pcZeq, "+(", "'", names(e.odd.pcaScenter[j]), "'", "—(",
e.odd.pcafcenter[j], ™), ")/", e.odd.pca$scale[j], "*", e.odd.pcaSrotation[],

2])

## +('sll'-(47.51488))/0.2701003*-0.005176845+("s12"'-(521.4501))/0.7517117*%0.05515457+("s13"'-(2388.09))/0.07484883
*—0.2340729+ ("'s14"'- (8143.502))/15.7565*0.666%612+("s15"'-(8.438634))/0.03782789%0.02555775+("'s17'-(353.0714))/1.561
964*0.0864907+('s2"'-(642.638))/0.5043607*%0.02942645+("'s20"-(38.83337))/0.1812555%-0.02673732+("'s21"'-(23.29963)) /0.
1083B872%-0.0353763%+("'s3'-(1590.048))/6.186516*0.08201156+("'s4"'-(1408.104))/9.077463%0.02025%07+ ("'s6'-(21.60976))/
0.001539259%-0.04061592+("s7'-(553.4522))/0.8983562*%0.0456855868+('=s8"'-(2388.091))/0.07388822%-0.2283776+("'s9"'-(906
4.651))/22.72082%0.6501037+('settingl'-(-3.554925e-05))/0.002184843*-0.0046704464 ("setting2'-(5.022518e-06))/0.000
2931999*-0.00808504
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Part Il — Ready the Prediction for Deployment usin g PI
Analytics

With the model trained in R, we have developed the equations that will allow us to predict the failures
before they occur based on the engine sensor and settings data. These can be expressed as arithmetic
equations and configured into the engine template in AF. We can then run these calculations in AF
using Pl Analytics. By doing so, we are able to run the model in real-time, using any newly observed
sensor and settings values to warn us when a failure is anticipated and prevent unexpected shutdowns.

In this part of the lab, we will be testing our predictive equations against the data we have already
loaded in our Pl system. Remember, the analysis we did using R only involved 50 of the 100 engines in
our sample dataset. We have still not seen how well things will work with the remaining 50 engines. To
perform this test, we will use the backfill feature of Pl Analytics to see if our equations will accurately
predict an engine failure before it actually occurs.

The predictive analytic equations developed in Part |l of this lab have already been configured in the
Engines AF model. To see them, go into the “Library” section and select the “Engine” template.

& \\PISRVO1\Engines - PI Syste
Eile Niew Go Tools Help
@ Database [% QueryDate = O @ |3 Back B, Checkin ¥} « [&] Refresh | gl New Template ~ igh New

Library ||Engine _
S Engines | General | Atiibute Tempiates |Ports | Analysis Templates |
B @ Templates
i Element Template ;
- I% ent Templates |H‘rer
; GfEngne
e ‘f 1% 8 Name 2 Destripbion Default Value
_' o [y Model Templates
P e TR Transfer Templates B [l category: Engne Sensor
I @ Erareralion So e e ssasae e e
i 1 R
f#l- % Reference Types Géi ............................ 3
i [ Tables sz o
- [E Table Connections I T T T
= ] Categarics | | s | .g R
i @] Analysis Categories 4 o
(] Attribute Categories | | fike | |
(] Blement Categories s Opsia
- (L] Reference Type Categories | B =
i (4] Table Categories | | @_56 | 0psia
G 57 0psiz
7 Hements | | 0
8 Orpm
== Ewent Frames I 1 & 1 t
s, 9 O rpm
- Library I | |
10 b]
n Unit of Measure Gas
Ilﬂ A sl ]
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In the “Analysis Template” tab, and you will see that three analyses have been added to this template.
Selecting the “Engine Failure Prediction” analysis will take you to the screen shown below. (Selecting
each step of the analysis calculation will expand its view showing more detail.

Engine

| General | Attribute Templates | Ports [IAnalvsis Templates u

| g Name: Engine Failure Prediction
& ame Description:  Predict pcl,pc2 pema3
fta J|Engine Failure Prediction . (
Categones:
fsa Engine Runtime L
H Failure Event Frames Analysis Type: @) Expression () Re
Example Element: Engine 1
=4 |Evaluate - Fun
MName  Expression Value Output Attribute Inse
zpcl |+("s11'-(47.51488))/0.2701063%0.36090913+( 512" - (521.4961) ), pcl ‘@ - Al
+{'s11"-(47.51488))/8.2781883%8.3098513+( '512"'-(521.4981))/0.7517117*-8.3849236 |~ Abs
+{'s513"'-(2388.09))/0.087484883%0.2845465+( "'514 " -(8143.582) ) /19.7965%8. 4163657 - Aco
+{"515"'-(8.438634))/8.83782739%8.2868222+( 's17"'-(393.8714))/1.561964%8. 2685557 =l »| And
+{"s2"-(642.5638))/8.5843687%0.2734667+( '528"'-(38.83337))/8.1812555%-8.2319219 Abs(j
P AL T TR A T T 1 T = T N O 0w I s, S T T B O I 1 O e L I Vi SO 0 2 D W = W P T W A B Tt e W W A
[T} Retur
Exam
zpc2 +("settingl’-(-2.080083555))/0.002185%0. 08467+ ( "setting2 ' - (¢ pc ®
pcmal | (zpcl + PrevWal('pcl',"*')+Prevwwal( 'pcl’,PrevEvent(’'pcl’, " pcmas ® -
tir
b

The failure prediction has three steps;

1. Calculate of principal component 1, zpcl, using the equation derived from the R script in Part I|
of the lab.

2. Calculate pcma3 - the three minute moving average of principal component 1,.

3. If the moving average is above the threshold value of 6.5, set the predicted status tag to a digital
state value of “Will Fail”. Otherwise, set the predicted status value to “Ok”.

In the “Library” section, we are viewing the Engine template. The “Example Element” has been set to
“Engine_1". Clicking on the Evaluate button will perform the analytic using data from the Engine_1
element. If you would like to evaluate the predictive analytic for other elements, navigate back to the
“Elements” section of Pl System Explorer and choose the “Analysis” tab from any engine element.
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= Category: Failure Prediction
s0B€ | oF pal
B ES | oF pe2

O Be | ¢F Predicted Status

Pt Created
Pt Created

Pt Created

Now that we have reviewed the predictive calculation in Pl Analytics and have evaluated it, we can now
backfill the calculation for all 100 engines to see how well it works. Again, the data for 50 of these
engines was not included in our R analysis, so we need to verify that our methodology will work.

It would be tedious to manage the analytics for 100 engines one-by-one so we will use the features of
the “Analyses” section of Pl System Explorer to make this much easier. Select Analyses from the menu
in the bottom left-hand corner of the PI System Explorer to get to the screen below.

Analyses
- Choose a filter -
None

Analyses

|| 0 total analyses selected (0 on this page)

1-302 of 302

All (302)

(§ Elements

== Ewvent Frames

i Library

ez Unit of Measure

[] status ® Element
fiea Engine 2
fiea Engine_1
fi4 Engine_100
fto Engine_99
ft4 Engine_58
fe4 Engine_87
ft4 Engine_96
fi4 Engine_54
fio Engine_33
ft4 Engine_32

OOoooooooOoO
9000900006 S

Name

Engine Failure Prediction
Engine Failure Prediction
Engine Failure Prediction
Engine Failure Prediction
Engine Failure Prediction
Engine Failure Prediction
Engine Failure Prediction
Engine Failure Prediction
Engine Failure Prediction
Engine Failure Prediction

Template

Engine Failure Prediction
Engine Failure Prediction
Engine Failure Prediction
Engine Failure Prediction
Engine Failure Prediction
Engine Failure Prediction
Engine Failure Prediction
Engine Failure Prediction
Engine Failure Prediction
Engine Failure Prediction

Backfilling

0000000000

W

] Analyses

Analysis Details

®

| Pending Operations

Mo pending operations

The Analysis view contains a complete tabular list of all the analytics configured for the Engines AF

model. From here, we can start, stop, or backfill selected groups of analytics.

To start the Engine Failure Prediction, select the checkbox to the left of the “Status” column — this will
select all the 100 engines. Then click the “Start” link on the right. The Pl Analytics service will Start
them all and you will see a green icon for each analytic in the “Status” column.

Analyses Analyses
ﬁ::::e a filter - |Y | 100 total analyses selected {100 on this page) 1-302 of 302 operat:ms- ‘
[E] Status ®  Element Mame Template Backfilling Mﬁ}iﬂ@s
All(302) @ fto Engine_ 2  Engine Failure Prediction Engine Failure Prediction [.~] - §M4’5Ffe d analyses
= o e e 2 = Backfill 100 selected analyses
[w] @ fto Engine_i  Engine Failure Prediction Engine Failure Prediction ]
@ f@@ Engine_100 Engine Failure Prediction Engine Failure Prediction (]
@ f@@ Engine_99 Engine Failure Prediction Engine Failure Prediction (/]
@ f@@ Engine 98 Engine Failure Prediction Engine Failure Prediction (]
@ f@@ Engine_97 Engine Failure Prediction Engine Failure Prediction /] | Pending Operations
@ Hement @ | foy Engine_%6  Engine Failure Prediction Engine Failure Prediction /] No pending operations
{—{ Event Frames @  fi) Engine_94 Engine Failure Prediction Engine Failure Prediction (V]
i Library @  fi) Engine_93 Engine Failure Prediction Engine Failure Prediction [.~]
= Unit of Measure [+ (%] fio Engine_92  Engine Failure Prediction Engine Failure Prediction ] W
Ilﬂ}] Analyses Analysis Details @
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Once the analytics are all running, click the “Backfill” link to Operations
Start 100 selected analyses
Stop 100 selected analyses

12:00 am to 21-Feb-2016 7:00 am. Click Queue to begin the Backfill 100 selected anaipges
backfilling process. You will see progress bars appear for each

open the time range dialog. Set the tie range to 21-Feb-2016

Start |2/21/2016 12:00:00 AM =
analytic as the Pl Analytics Service performs the calculation , =

End |2/21/2016 7:00:00 AM n
over the prescribed time range.

Event frames in the time range are deleted
before backfilling begins. The time range is
expanded to include event frames that start
or end inside the spedified range. End time
is adjusted to exclude active event frames.

For expression and rollup analyses, existing
data will not be removed or replaced.

Now, you can return to the “Elements” section of Pl System Explorer to look at the results. Use the
Explorer’s trending tool to examine the data. Select any engine and from its “Attributes” tab right-click
on the “Predicted Status” and Trend it. Close the trend window and right-click on the “Status” attribute
and Add to Trend it. For Engine 29 you will see the trend below. Taking a closer look, you can see that
our prediction comes a few minutes before the engine actually fails. It works!

= Trend == -
Start Time: [2/20/2016 11:59 PM ||E||T| End Time: [2/21/2016 7:00 am ||E||T| F”?‘
® Engine_29|Predicted Status O Engine_29%|Status
will Fail Stopped

2/20/2016 11:59:00 PM 7.02 hours 2/21/2016 7:00:00 AM

[ add Attributes... | [ AddPiPonts... | | Traces.. || Close

You can confirm it by checking a few other engines in the above manner.
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Appendix A: Using Power Bl to Evaluate the

Predictive Model

After we have configured and backfilled the engine failure prediction using Pl Analytics, we would like to

see if our predictive model will be effective in warning us of potential engine failure. We would like to

know how far in advance the predictive model first warns us of an eventual failure. And we would like

to do this for all 100 engines in an easy way.

To accomplish this, we will use the Pl Integrator for BA to create another text file containing the “Status”

and “Predicted Status” attributes for all 100 engines over the entire time range. The text file we create

can be imported and quickly analyzed in a tool such as Microsoft Power Bl Desktop.

Return to Internet Explorer and access the Pl Integrator for BA User Interface. Create a new Asset View

and give it a meaningful name like, “Failure Prediction Test”. Select data from the “Engines” AF Model

using the steps listed below,

e Select “Engines” from the Database dropdown.

e Select and drag element “Engine_1" to the “Asset Shape” area.

* Select and drag attribute “Predicted Status” and drop it as a child to the “Engine_1" element in

the “Shape Asset” area (position the cursor on top of “Engine_1" and observe the tooltip).

* Repeat the step above for attribute “Status”.

e Click the edit pencil next to element “Engine_1" in the “Asset Shape” area. Uncheck the filter on

“Asset Name” and check the filter on “Asset Template”. This will expand our selection to

include all 100 engines which have been derived from the “Engine” template in our AF database.

Once you complete these steps, the Pl
Integrator for BA User Interface should

) Source Assets

Select Data > Modify View > Publish

look like the one shown here. Server PISRVOT

[«

Database Engines

[ &

@ Assets

| 8 Engine_1

@ Engine_10
@ Engine_100
@ Engine_n
@ Engine_12

@ Engine_13

Attributes ‘F‘J’iet

« [

0O Select All

& rct
o pc2

& pcma3

§ Predicted Status

4 Runtime

39| Page

T, Search Shape
T Asset Shape
4 @ Engine
4 Predicted Status

4 Status

+ Matches
Found 100 Matches

(@ Engine_1
(@ Engine_10
8 Engine_100
(@ Engine_11
@ Engine_12
(@ Engine_13
(@ Engine_14
@ Engine_15
(@ Engine_16
@ Engine_17
(@ Engine_18
(@) Engine_19
@ Engine_2
(@ Engine_20
@ Engine_21
(@ Engine_22
() Engine_23
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With the data selection step complete, click Next in the upper right-hand corner of the page to move to
the view modification step. This time, we’re not going to remove the engine “Stopped” events, instead
we will publish all the data for the entire time range. We’'ll let Power Bl Desktop provide the data
filtering functionality.

On the “Modify View” page, set the time period for the publication to be between 2/21/16 12:00 AM to
2/21/16 7:00:00 AM and click Apply. You should see the results shown below.

_;f' @ Pl integrator for Business X \_
&« C | & https://pisrv01/Designer
I Apps f@ Pl Integrator for Bus @ Pl Coresight @ P| Coresight - Test J=
= Bl Test 100 1 Gopal
Select Data > Modify View > Publish
= Add Column Y Edit Row Filters Sl
4 columns 0 Row Filtee | A m |
Engine._ 1 TimeStamp Predicted Status | Status
Engine_1 2/21/16 1:25 AM Ok ‘Running
Engine 1 2/21/16 1:26 AM Ok ‘Running
Engine_1 2/21/16 1:27 AM Ok :Running
Engine 1 2/21/16 1:28 AM Ok {Running
Engine_1 2121116 1:29 AM Ok ?Runmng
Engine_1 2(21/16 1:30 AM Ok ?Runm’ng
Engine 1 2121116 1:31 AM Ok ERunn\'ng
Engine_1 2/21/16 1232 AM Ok éRunmng
Engine_1 2/21/16 1:33 AM Ok “Running
Engine 1 2/21/16 1:34 AM Ok gFeunmng
Engine 1 2/21/16 1:35 AM Ok :Running
Engine 1 2/21/16 1:36 AM Ok {Running
Engine_1 2121116 1:37 AM Ok ?Runn\ng
Fnaine 1 22116 1°38 AM Ok ‘Runnina

With the data selection step
complete, click Next in the upper

Select Data > Modify View > Publish

right-hand corner of the page to move  Targst Configuration - Summary
to the publication step. For Target | ES——————— V| | Shape and Matches

. o . ~ - Th 100+ Matching Instances
Configuration, click on the drop down @ Run Once =

and select Text File. O Runona Schedule

Timeframe and Interval

= Your Start Time is 2/21/16 12200 AM

+ Your End Time is 2/2¥16 7:00 AM

= Your Time Interval gets an interpolated
measurement every 1 minutes

Since we only need to perform a one-
time publish of this view, select Run

Click on Publish to get the Pl Integrator to start publishing the dataset to a file. You will have to Confirm
that this is Ok. Once the publication is complete, you will find the text file has been created in “C:\Data
Science Lab” folder.
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For the analysis, we will be using Microsoft Power Bl Desktop. To open it, click
tJd

Power BI
Desktop

The first step is to import the text file we just created into Power Bl Desktop. From the top menu
ribbon, click on “Get Data” to expose the dropdown shown at right below. Select “More...” at the
bottom of the list. This will open the “Get Data” dialog where you can chose “Text” as you data source.
Click Connect at the bottom to open the File Open window. Navigate to the “C:\Data Science Lab”
folder and select the file you published.

Modeling
w o B E .
Get | Recent Enter E Get Data
T |DatalySources~ Data Qu
Most Common 3 All
Al Bl A
Excel File [l csv
Database B xm
SGL Server Azure 8 w2
Other E] sson
Folder
Analysis Services
SQL Server Database
B Access Database
csv SQL Server Analysis Services Database

Oracle Database

1 Web IBM DB2 Database

MySQL Database

PostgreSQL Database
OData Feed

Sybase Database

Teradlsts Database
G Blank Query 28 Microsoft Azure SOL Database w7

More... Con 5 Ccancel
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Once you open the text file,
Power Bl will present the
data preview window.

Failure Prediction Test 20160317174327 txt

Engine TimeStamp.Local Predicted Status Status
~
Engine_1 | 2/21/2016 12:00:00 AM Started
We would like to remove Engine_1 | 2/21/2016 12:01:00 AM Running
the blank values shown Engine_1 | 2/21/2016 12:02:00 AM Running
" i ” Engine_1 | 2/21/2016 12:03:00 AM | Ok Running
under PFEdICtEd Status Engine_1 | 2/21/2016 12:04:00 AM | Ok Running
and also the timestamp Engine_1 | 2/21/2016 12:05:00 AM Ok Running
. Engi 1 2/21/2016 12:06:00 AM | Ok R i
column. To edit the dataset ngine 1 | 2/21/. anmne
i . , Engine_1 | 2/21/2016 12:07:00 AM | Ok Running
before we import it we’ll Engine_1 | 2/21/2015 12:08:00 AM | Ok Running
click on Edit. (Clicking Load Engine_1 | 2/21/2016 12:09:00 AM Ok Running v
. . . Fineil 11 2212006 12-1040 AN | Ok 2] i
will bring the data directly e e
in Power Bl Desktop.) Load Edit Cancel
Once we click Edit, the Power Bl Desktop Query Editor window is shown below.
File Home Transform Add Column View : O
i." » i —"I | D‘w:l Properties :. % El _ [IO DataTypeiText~ e
= D (D D 5 51 Advanced Editor m HXH ':l | e @ Use First Row As Headers ~
Close & MNew Recent  Enter Refresh Choose Remove Reduce Group Combine
Apply~  Source ~ Sources~ Data Preview = Columns Columns~ Rows~ Column= By 2 Replace Values =
Clase Mew Query Query Manage Columns Sort Transform

1 Query

| % Failure Prediction Test_201603171...

4 COLUMNS, 999+ ROWS

TimeStamp.Local

2/21/2016 12:00:00 AM

2/21/2016 12:01:00 AM

2/21/2016 12:02:00 AM

2/21/2016 12:03:00 AM | Ok
2/21/2016 12:04:00 AM Ok
2/21/2016 12:05:00 AM | Ok
2/21/2016 12:06:00 AM | Ok
2/21/2016 12:07:00 AM | Ok
2/21/2016 12:08:00 AM | Ok
2/21/2016 12:05:00 AM Ok
2/21/2016 12:10:00 AM | Ok

- Predicted Status

‘ Status

Started

Running
Running
Running
Running
Running
Running
Running
Running
Running

Running

Query Settings

4 PROPERTIES
Name

Failure Predic

4 APPLIED STEPS

Source
Promoted Hea-dek
X Changed Type

PREVIEW DOWNLOADED AT 10:46 AM
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Select the timestamp column and click the “Remove (3 Eapropertes B[] 8 |
. . . e DAdvan(ed Editor El = Use Fir
Columns” item in the menu ribbon. Choose “Remove  Refresn. Groose RN educe| ™ | <ot Growe fw“
Columns” to take this colum out of our dataset. Query Managel (¥ Remove Columms N S—
Iﬁl Remove Other Colufhns
= Table.Tran_. = ccm ey rem g =« —wem == Headers"™,
Note: This action does not affect the text file, it only : ML AN reicied status [ seaeus
. . . A Engine_ 1 2/21/2016 12:00:00 AM Started ~
instructs Power Bl to not import this column from the : B 2/21/2016 12:01:00 A Running
. EQl Engine 1 2/21/2016 12:02:00 AM Running
text file. POl cngin=_L 2/21/2016 12:03:00 AM Ok Running
LRl Engine 1 2/21/2016 12:04:00 AM Ok Running
[ Enzin=_1 2/21/2016 12:05:00 AM Ok Running
P Engine_1 2/21/2016 12:06:00 AM Ok Running
Q) Enzine_1 2/21/2016 12:07:00 AM Ok Running
[*B Engine_1 2/21/2016 12:08:00 AM Ok Running
RO Encine_1 2/21/2016 12:09:00 AM Ok Running
IR Ercine_1 2/21/2016 12:10:00 AM Ok Running v
- = == =
Select the “Predicted Status” column and j 8] Sort Ascending
. . = | Predicted 5tatus i Z| SortDescend
click on the down arrow to expose the filter {W# AL sort Descending
. . 51
list shown below. Uncheck the “(blank)” item p % Cearfiter
to remove rows containing blank values of . Text Fiters ’
the Predicted Status. Ok R !
(Select All)
Ok Ri {blank)
ne ™ ¥ Ok
& Will Fail
Note: We are getting two blank values for the Predicted Status _ _
I List may be incomplete. Load more
because our calculation fails for the first two minutes of the backfill - i

time range since we are using a three minute moving average and
there are missing values until we get to the third minute of the calculation.

Referring back the screenshot at the top of this page, you will see that as you perform the steps above,
they are recorded by the Query Editor in the “Applied Steps” window.

We are now ready to import the edited dataset into Power Bl Desktop.

Home Transfarm
Select “Close & Apply” from the menu ribbon and select “Close & Apply”. =X D D D
Power Bl will now import the dataset from the text file, applying the =t O
Close & Mew Recent  Enter
filtering steps you have specified. Apply~| Source~ SourcesT Data
. Close & Agply ey
Once the data has been loaded, you will be returned to the Power Bl =t APPlY
Close

Desktop reporting canvas shown below.
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Home Madeling

« GLhEDLEREC0 = (B .

Bl Copy
> N Get Recent  Enter Edit Refresh New New Page Manage New Publish
Formst Painter  Data- Sources> Data  Queries Page~ Visual EIShapes = yiew~ Refationships  Measure -

Clipbaard External Data Insert View  Relationships Calculations  Share

Visualizations > Fields

» B Failure Predictio.

Iﬂ.t‘gn
HE

—

o
b
=
R
&

Filters

PAGE 10F 1

With the data loaded, we’re just a few simple steps to finishing our analysis. In the Fields
“Fields” area at the right, expand the table to see the columns in you dataset.

From the “Visualization” area, select the Clustered Column Chart. To configure the 'f o
Engine

chart, select, drag, and drop the “Engine” column into the “Axis” field. Repeat this M Predicted Status
by placing the “Engine” column in the “Values” field. You will notice that since this —
column contains text, the engine number, Power Bl converts this to a record count.

Visualizations

r = e

Clustered column chart |
e Farlure P

i Engine
= \ESE | | Predicted Status
N Status
] ]
L | s elds hers

Count of Engine

Page 1 +

Taking a look at things, we see that we have a bar chart that shows the number of records for each
engine in our dataset. As expected, since we did not filter the publication to exclude times when the
engine was “Stopped”, there are the same number for each engine. Not too interesting.

However, recognizing that each record represents one minute of operation, we can use some slicers,
based on the “Status” and “Predicted Status” columns to finish the analysis.
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What we are looking for is the amount of time (number of records) where the Predicted Status has a
value of “Will Fail” and the “Status” is “Running. Select the bar chart object handles and make some

room in the reporting canvas for a couple of slicers.

Select the “Predicted
Status” column and
drag it onto a free space
on the canvas. While
it’s still selected, click
on the Slicer to convert
the list to a slicer visual
object.

Create a second slicer
for the “Status” column.

Rearranging the size of things and filtering the record counts (minutes) for each
engine gives the analysis shown below. In the upper right-hand corner of the
bar chart, you can sort the data by “Count of Engine” to make things easier to

assess.

Predhcted Fatm
Ok

o
W il Fail

&

Page 1 +

[ S

[

Engine_16

E 17

Visualizations

Predicted Status
Status

&

Predicted Status

Filters

L] Visualizations|

Sort By ~
Engine

Count of Eﬂg\r'\{T‘j I =
m ®

L1 Exportddcountof Engine
R -

You can conclude that for Engine_16, we predicted that it will fail 17 minutes before it actually fails.

And, similarly for the other engines.

Also, since the bar chart is in descending sort order, we can also conclude that 17 minutes (or cycles) is

the maximum.

In the R session (Part 1l), we had seen similar results.
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Appendix B: Using Pl WebAPI with R

If you prefer, you can stay completely within the R environment — and read/write Pl System data using
PI WebAPI, available as part of the Pl Developer technologies
https://livelibrary.osisoft.com/LiveLibrary/web/ui.xgl?action=htm|&resource=publist_home.htmI&filter

=developer

As such, all the three parts, namely, Part | Extracting Pl System data, Part Il Predict Equipment Failure
Using Statistical Analysis, and Part Ill Ready the Prediction for Deployment can all be done entirely using
R and Pl WebAPI.

Local Disk (C:) » Data Science Lab

- MName ¥ | Date medified Type
a EngineAll.html 318/2008 217 AM - HTML Docurnent
il| Engine Failure Prediction Analysis.pbix 318/2016 &:09 PM Microsoft Power B...
E’ EngineScript.R 3/23/2016 5:36 PM R File
) piwebapi.R 3/10/2016 235PM R File
Ej piwebapi_main.R 3/10/2016 4:46 AM R File

For more details, please refer to the R code samples in the files with “piwebapi” prefix in their names.

The PI WebAPI approach is particularly useful when the predictive machine learning models are complex
—such as those based on decision trees, neural net etc. and hence cannot be deployed using Pl AF
Analysis.
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Appendix C: Follow-up questions from Part

Follow up questions

How will you improve the prediction? What other criteria besides “threshold for PC1 — three moving

average” can you use?

Is the selection for the training data set i.e. engines with odd ids the best technique or can you suggest a

better criteria?

In this lab, we use only PC1; how will you incorporate PC2 - will it improve your prediction?
Which variables have the most influence on PC1 (and PC2) - and in what proportion?
What other statistical or machine learning approach can you use to predict engine failure?

Why does the PCA approach work so well in this use case?
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Reference Materials

The data used for the lab has been adapted from:

A. Saxena, K. Goebel, D. Simon, and N. Eklund, “Damage Propagation Modeling for Aircraft Engine Run-to-Failure Simulation”, in
the Proceedings of the Ist International Conference on Prognostics and Health Management (PHMO08), Denver CO, Oct 2008.



